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Featured Launch: New Google Contacts 
 

Enable the new Google Contacts for your users from the Admin console 

 Announced March 29th, 2016       Share with your organization  

 
What’s new: Last year, we launched the new Google Contacts preview to consumer users with several 
time-saving improvements, such as a rebuilt “Find duplicates” feature, automatic updating of contacts with 
shared Google profile information, as well as a fresh look and feel. Now, we’re pleased to announce that several 
new improvements have been added at the request of Google Apps users and we’ve making it possible for 
Apps admins to enable the Google Contacts preview for their users from the Admin console. 
 
Getting started with the new Google Contacts preview 
This new Admin console setting is off by default, giving admins full flexibility to enable the new Contacts 
preview on their own schedule. To enable this feature in the Admin console, click on Apps > Google Apps > 
Contacts> Advanced settings. Once enabled, all users will see the new Google Contacts by default and will 
have the ability to switch back to the old Google Contacts by using the “Leave the Contacts preview” link from 
the More section of the left-hand navigation menu. 
 

 
 
After enabling this feature, when users next visit Google Contacts they will see the new UI and a “warm 
welcome” splash page will guide them through the new features. 
 

 
 
 
 
Key improvements 
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https://gmail.googleblog.com/2015/03/the-new-google-contacts-bringing.html
https://support.google.com/mail/answer/1069629


 

 

 

Easily get rid of duplicates: No one likes having duplicate contacts, but they inevitably crop up. So we’ve rebuilt 
our “Find duplicates” feature from the ground up to provide a quick and painless way to clean up your 
duplicates. 

 
 
Improved Domain Directory: The directory is easier to navigate through a more intuitive and faster “infinite” 
scroll. 
 

 
 
Automatically Updated Contacts: Users can keep their contacts up to date automatically with shared 
information from the domain directory, Google+ (if enabled), and more. In addition, Google Contacts also now 
supports high resolution photographs. 
 

 
 
Limitations and switching back to the old Contacts 
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The following features are not yet available in the new Google Contacts: 

● User Custom Fields 
● Contact delegation 
● Editing group email preferences 
● Import/Export 
● Print 

When people try to use these features, they will be prompted with a message that these features are not 
supported as of yet and presented with a link to go back to the old Google Contacts. 
 

 
 
To optout and switch back to the old Google Contacts, users can click More > Leave the Contacts preview 
from the lefthand navigation of the Google Contacts preview. 
 
For more information about the new Google Contacts, check out the Help Center. 
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http://googleappsupdates.blogspot.com/2016/03/user-custom-fields-from-directory.html
https://support.google.com/mail/answer/6164066


 

Work together 
Set expiration dates for access to Google Drive, Docs, Sheets, and Slides files 
 

  Announced March 15th, 2016       Share with your organization  

 
What’s new: We know that businesses today don’t operate in isolation; employees work not only with one another, 
but with third-party vendors, clients, customers, and other businesses as well—and often on a temporary basis. To 
keep your organization’s information safe in these situations, we introduced the ability to set an “expiration date” 
for specific user access to files in Google Drive, Docs, Sheets, and Slides. 
 
For instance, imagine your business hires an outside contractor for a project lasting three months. To complete 
the job, that contractor needs to view a spreadsheet containing the contact information of your employees. 
Following this launch, you are now able to share your employee list in Sheets with the contractor, give them 
view access only, and set that access to expire when their contract does (in three months). If the contractor 
attempts to open the spreadsheet after the expiration date has passed, they’ll be denied access. 

 
 
This functionality, coupled with the Information Rights Management (IRM) features we launched last July, 
should significantly increase the security of your organization’s documents and information. 
 
Please note that you’ll only be able to set expiration dates for users with comment or view access; you will not 
be able to set expiration dates for file owners or users with edit access. 
 

IMPORTANT: This feature will roll out gradually over the course of two to three months; please note that you 
may not see the feature in your domains until mid- to late Q2 2016. 
 
For more information, learn about changing your sharing settings and sharing files and folders in Google Drive in the 
Help Center. 
 

  

5 

http://googleappsupdates.blogspot.com/2015/07/disable-downloading-printing-and.html
https://support.google.com/drive/answer/2494893
https://support.google.com/drive/answer/2494822


 

 

Work anywhere 
 

Improved Trash support and folder colors in the Google Drive for iOS app 

 Announced March 9th, 2016       Share with your organization  

 

 
What’s new: An updated version of the Google Drive 
for iOS app is now available in the App Store. New 
features include: 

● Trash View: You’ll now have the ability to 
view, restore and delete items in your trash 
from within the iOS app. > 
 

● Folder Colors: You can now view and modify 
your Google Drive folder colors on the fly. 
 

More Information 

● Organize your files in Google Drive 
● Delete and restore files in Google Drive  
● Get the latest Google Drive iOS app in the 

App Store 

 

 

Better collaboration, more options with the latest Docs, Sheets, and Slides Android 
apps 

 Announced March 10th and March 23rd, 2016       Share with your organization  

 
What’s new: New versions of the Google Docs, Sheets, and Slides apps for Android are now available on Google Play. 
 
In the Docs Android app, you can now: 
 

● Select, copy, and comment on content in Print Layout view. 
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https://support.google.com/drive/answer/2375091
https://support.google.com/drive/answer/2375102
https://itunes.apple.com/us/app/google-drive-free-online-storage/id507874739
https://itunes.apple.com/us/app/google-drive-free-online-storage/id507874739
https://play.google.com/store


In the Sheets Android app, you can now: 

● Send a copy of or save a spreadsheet as an HTML web page file (provided in a .ZIP folder) from the 
Share & export menu. 

● Save the sheet you’re currently viewing as a .CSV or .TSV file from the Share & export menu. 
● View Google Drawings in spreadsheets (note that Drawings will not be visible in frozen rows and 

columns). 

 
 
In the Slides Android app, you can now:  
 

● Send a copy of or download the slide you’re currently viewing as a .JPEG, .PNG, or .SVG file from the 
Share & export menu. 

● Create and edit presentations that read from right to left, a necessity when presenting in languages such 
as Hebrew and Arabic. 

 

 
 

 More Information 
● Help Center: Edit and view text from right to left 
● Help Center: Print a document, spreadsheet, or presentation 
● Help Center: View and create spreadsheets on Android 
● Help Center: Use the Google Slides app for Android 
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https://support.google.com/docs/answer/177123
https://support.google.com/docs/answer/65166
https://support.google.com/docs/answer/143346
https://support.google.com/docs/answer/3421043
https://support.google.com/docs/answer/6042786


 

 
 

Swipe to preview, reverse sort, and more in the new Google Drive for Android app 

 Announced March 21st, 2016       Share with your organization  

 
What’s new: A new version of the Google Drive for Android app is now available in Google Play. New features 
include: 
 

● Swipe to preview: You can now swipe through your Drive folders faster while in preview. This lets you 
quickly scan through all your favorite Google Drive files. 

 

● Reverse Sort: We’ve heard feedback that you want more flexibility in how files are sorted. We’re adding 
the popular request to allow reverse sorting. Simply tap the sort column at the top of Drive to swap the 
sort order. 
 

● Instantly edit with your favorite apps: If you have an editor app installed on your device, you can now 
jump into the editor directly from the file preview in Google Drive. This is great if you want to make 
changes on the fly and have those changes saved back to Google Drive. Some common editor apps 
include Google Photos, Google Docs, and more. 

 

 

Get the latest Google Drive Android app on Google Play 
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https://play.google.com/store/apps/details?id=com.google.android.apps.photos
https://play.google.com/store/apps/details?id=com.google.android.apps.docs.editors.docs&hl=en
https://play.google.com/store/apps/details?id=com.google.android.apps.docs


 
 

Change your filters, themes, and layouts in the Sheets and Slides apps for iOS 

 Announced March 23rd, 2016       Share with your organization  

 
What’s new: New versions of the Google Sheets and Slides apps for iOS are available in the App Store. With 
these updates, you can now: 
 

● View and modify existing filters in the Google Sheets iOS app. 
 

 
 

● Change the theme or layout of a presentation in the Google Slides iOS app. 

 

 
Get the Sheets and Slides apps in the App Store 
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https://support.google.com/docs/answer/6344805
https://support.google.com/docs/answer/1694986
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Simple to use  
 

Easily convert text to columns in Google Sheets 

 Announced on March 1st, 2016       Share with your organization  

 
What’s new: We know that copying data and pasting it into a spreadsheet can be a pain if the data does not 
separate neatly into columns. With that in mind, we’ve added a feature in Google Sheets that allows you to split 
delimited data (e.g. data separated by commas) from one column across multiple columns. 

 
There are a few ways you can split delimited data across columns. For example, you can select the columns 
you want to split, and click Data > Split text to columns. A menu will then appear underneath the data, allowing 
you to split the data using commas, semicolons, periods, spaces, and even custom separators. 

 
 

In addition to the “Split text to columns” option, you can also format cells containing delimited data using a 
contextual menu that appears immediately after you’ve pasted data. You can choose a custom separator 
through this method also.  
 
Check out the Help Center to learn more.  
 
 

New templates in Google Docs: designed by experts, made for you 

 Announced on March 2nd, 2016       Share with your organization  

 
What’s new: We launched a collection of templates in Docs, Sheets, and Slides in September to give your 
documents, spreadsheets, and presentations the extra polish they deserve. This launch adds to that collection 
with new templates designed by five experts in their fields. All templates are available on the web and on 
Android and iOS. 

 
For your big ideas, at work and on the go 
Intuit's QuickBooks software helps small business owners get more out of financial planning with tools like 
automated budgeting, tax time reports, and payroll. Use the new annual business budget template by 
QuickBooks in Sheets to easily manage your budget so you can focus on building your business. 
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https://support.google.com/docs/answer/6325535
http://googledocs.blogspot.com/2015/09/sidekicks.html
http://www.quickbookspartners.com/google-budget-template/?utm_source=google%20template%20gallery&utm_medium=branded%20link&utm_campaign=google%20partnership


 

 
 
GV provides venture capital funding to bold new companies. In the fields of life science, healthcare, artificial 
intelligence, robotics, transportation, cyber security, and agriculture, GV’s companies aim to improve lives and 
change industries.The new GV pitch template in Slides helps entrepreneurs share their vision, based on proven 
presentation tactics. 

 
And, in the bestselling book, Made to Stick, brothers Chip and Dan Heath revealed that “sticky” messages of all 
kinds draw their power from the same main traits. In their big idea template in Slides, they use these principles 
to help you build and deliver your most memorable presentation yet. 

 
For a head start, at school and beyond 
Reading Rainbow, the third-longest-running children's TV series in US history and award-winning digital service, 
has been inspiring children to read for more than 30 years. Reading Rainbow created a lesson plan and a book 
report template in Docs to help teachers and students get things done. 

 
The Google Science Fair (GSF) is an annual online science and engineering competition open to teens globally. 
In the competition, young scientists have tackled issues like world hunger, life-threatening diseases and the 
energy crisis. Use GSF’s science fair template in Slides for a head start on your next project—or for this year’s 
GSF. 

 
Jump-start your next project with these easy-to-use templates in Docs, Sheets, and Slides—available on the web 
and on your Android device or iPhone.  
 
 

Employees can view and access their apps from the new User Hub 

 Announced on March 2nd, 2016       Share with your organization  

 
What’s new: With this launch, an employee can quickly and easily see a list of the Google and third-party apps 
they have access to, like Gmail, Drive, SurveyMonkey, and more, at apps.google.com/user/hub.  
 
This page features links to all the apps currently turned on for that user, as well as a section dedicated to those 
apps that have been whitelisted by their admin but not yet installed. This should encourage employees to use 
their enabled apps more often and to finally check out those apps they haven’t yet tried (especially the mobile 
versions, which will be easier to access). New users will also be directed to apps.google.com/user/hub during 
the onboarding process. 
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https://www.gv.com/
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https://www.readingrainbow.com/
https://www.googlesciencefair.com/en/?utm_source=Docstemplatelaunch&utm_medium=Blogpostandsocial&utm_campaign=docstemplatelaunch
http://apps.google.com/user/hub
http://apps.google.com/user/hub


 

 
 
Note that an individual must be signed in to their Apps for Work account to access apps.google.com/user/hub.  
 
Check out the Help Center for more information. 
 
 

Export Google Docs files as EPUB publications 

 Announced on March 7th, 2016       Share with your organization  

 
What’s new: EPUB is the most widely supported file format for publishing accessible documents and digital 
books, allowing people to consume long-form content in their preferred apps on a diverse range of screen sizes 
and devices, including smartphones, tablets, and eReaders. To make it easier for authors, publishers, and 
academic institutions to create works that can be consumed digitally, we’ve launched the ability to export 
Google Docs files as EPUB publications. Simply go to the File menu > Download as > EPUB Publication (.epub). 
 

 

 

Check out the Help Center for more information. 
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https://support.google.com/a/answer/6367746
https://support.google.com/books/partner/answer/3316879
https://support.google.com/drive/answer/2423534


 
 

Navigate documents quickly and easily with the outline tool in Google Docs 

 Announced on March 9th, 2016       Share with your organization  

 
What’s new: It can be difficult, not to mention time-consuming, to navigate lengthy, complex documents. To 
make that process easier, we’ve launched an outline tool in Google Docs on the web and Android. Displayed in 
a pane to the left of the page, this outline features headers for each section of your document, making it simple 
to quickly jump from section to section. If you haven’t manually applied headers, no worries—we’ll do it for you, 
intelligently detecting the logical divisions within your work. You can then edit or remove these headers as 
necessary. 
 

 
 

 
This launch also allows you to move through 
documents on your Android phone or tablet at super 
speeds. When you begin scrolling on your mobile 
device, a small navigation handle will automatically 
appear. Touching that handle will display the entire 
document’s structure, allowing you quickly skip from 
section to section, instead of slowly swiping up and 
down. 
 
To surface an outline in your document, simply click 
Tools > Document outline in Docs on your computer 
or select Document outline from the overflow menu 
on your Android device.  
 
Check out the Help Center for more details. 

 
 

Business ready 
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https://support.google.com/docs/answer/6367684


 
User custom fields from the directory now in Google Contact Manager 

 Announced March 1st, 2016, effective March 31st, 2016      Admin feature   

 
What’s new: Today, Google Apps administrators use custom fields in the domain directory to store information 
like Projects, Teams, Languages, and whatever else their organization needs. Showing these fields to users 
within the Google Contacts user interface has been a popular feature request for many domain administrators, 
because having this information accessible helps users connect more easily. 
 
With this launch, the Contact Manager at contacts.google.com will now show user custom fields from the 
domain directory. User custom fields will respect the permissions that the domain administrator has set. 
 

Example: 

● If you have user custom fields which you’ve set as only visible to administrators and users, this field will 
only be visible in the Contact Manager to the specified administrators and users. 

●  If you have fields which are visible to anyone at the domain, then these fields will now be shown in the 
Contact Manager to users within the domain. 

 

In the profile above, Profession, Active Projects, and Languages were stored in the "TeamInfo" schema. 

If you’d like to start using user custom fields, the Directory API is already available in Python, Go, Java, Apps 
Script, PHP, and more, giving administrators flexibility over what fields to add for users. To control whether 
fields are shown to users or just administrators, use the readAccessType property. 
 
If you’ve already added user custom fields, any user-visible custom fields that Google Apps administrators 
have added through APIs or Google Apps Directory Sync will now be visible to users as custom fields in the 
Contact Manager at contacts.google.com. To update the schema, use the Directory API. 
 

Limitations 

● Google Apps Sync for Microsoft Outlook users will not see custom fields in the Global Address List. 

Check out the Help Center for more information. 
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Automatically assign Google Apps licenses to new employees based on their 
organizational units 

 Announced March 3rd, 2016      Admin feature   

 

What’s new: We know that many of you work at large and organizationally complex companies, where different 
teams need different Google Apps products and services. This can make onboarding new employees a 
time-consuming and tedious process. 
 
This launch should make that process significantly easier, by allowing you to automatically assign licenses for 
Google Apps products and services at the organizational-unit (OU) level (until today, you could assign licenses 
at the OU level, but those licenses would not automatically apply to new users). This will be particularly useful if 
different employees in your organization need different Google Apps products, like Vault or Drive storage, or 
editions, like Google Apps for Work or Google Apps Unlimited. Note that you can still automatically assign 
licenses at the domain level. 
 
How it works: If you turn Auto-Licensing ON for a particular Google Apps product or service in a particular OU, 
all users currently in and subsequently added to that OU will receive that license. Users in child OUs will also 
inherit that license, unless you choose to override the setting. The Auto-Licensing setting can be found in the 
Admin console (Billing > Subscriptions); for more explicit instructions, check out the Help Center. 
 

 
 
 

Updated version (v4.2.1) of Google Apps Directory Sync 

 Announced March 3rd and March 31, 2016      Admin feature   

 

A new version (v4.2.1) of Google Apps Directory Sync (GADS) is now available for download: 
 
What’s New  

● API update  
○ GADS now uses the latest version of the Admin SDK Calendar Resource API.  

● Replace primary domain name with secondary domain name  
○ Added new feature to enable administrators to replace the primary Google Apps domain name 

with a secondary domain name for all GADS operations.  

What's Fixed 

● See the Help Center for a breakout of numerous bug fixes 

 

 

Connect with more people using Google Hangouts video calls 

 Announced March 16th, 2016       Share with your organization  
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What’s new: Google Hangouts video calls make it easy to connect and interact to get 
things done. With this update, to make it easier to connect with more people, we raised 
the participant limit for Hangouts video calls from 15 to 25 for Google Apps customers. 
 
To help ensure a high quality experience on a variety of computers, only the 10 most 
active video call participants will have their video feeds visible at the bottom of the 
screen at any given time. 

 

 
No action is required to make use of this new participant limit.  
 
Check out the Help Center for more information on Hangouts video calls. 

 

Easy and secure single sign-on for popular work apps 

 Announced March 3rd, 2016      Admin feature   

 
What’s new: Millions of Google Apps for Work customers rely on Google to protect their employees’ login 
information for Google Apps services like Google Drive and Gmail. With this and previous launches, we’re 
extending that ease and security to additional applications that businesses rely on. 
 
SAML (Security Assertion Markup Language) 2.0 allows individuals to use their Google login credentials to sign 
in to various enterprise cloud applications. In October 2015, we launched support for SAML 2.0 for more than 
15 popular SaaS providers, including Salesforce, Workday, and Dropbox. With this launch, several additional 
apps are now pre-integrated with our systems, including Microsoft Office 365, Facebook at Work, Concur, Box, 
and Slack. This adds to the hundreds of apps we already support through the Google Apps Marketplace and 
OpenID Connect. 
 

This launch not only makes the sign-in process easier for employees, it simplifies the management of end user 
IDs and passwords for Apps admins as well.  
 
For SAML set-up details and a full list of pre-integrated apps, please visit the Help Center. 
 

Searching for settings and articles in the Admin console now quicker and easier 

 Announced March 24th, 2016      Admin feature   

 
What’s new: We know that it often takes too long to find the item you’re looking for in the Admin console. To 
simplify your searches, we launched natural-language-based, “free form” queries in the Admin console. Admins 
can now pose questions in everyday language or enter commonly used words into the Admin console search 
box, then choose from a list of suggested results to navigate directly to your intended destination. There’s no 
need to jump from page to page! In addition to the tasks, users, and groups that would previously show up as 
search results, you’ll now see specific settings and prominent Help Center articles listed as well. 
 

 

 

Check out the Help Center article for more information on how you can save time searching the Admin console. 
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Mobile device management and more with the Google Admin app for Android 

 Announced March 28th, 2016      Admin feature   

 

What’s new: The latest version of the Google Admin app for Android brings many of the mobile device 
management (MDM) capabilities you love on your computer to your mobile phone or tablet. With this launch, 
you don’t need to be at your desk to view a list of your domain’s managed devices and to activate, block, delete, 
or wipe them. Because many of these actions may impact the security of your organization’s data, it’s important 
to be able to perform them anywhere, anytime. Now you can. 
 

     

 
In addition to these MDM features, the latest Admin app for Android automatically stores your preferences in 
the Cloud. Should you get a new device or uninstall (and then reinstall) the Admin app, your preferences will be 
restored. 
 
Check out the Help Center for more information, and download the latest version of the Admin app for Android on 
Google Play. 
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Learn more about Google Apps  
  
Google for Work Connect (GWC): The official community for Apps Admins 
 

   Admin resource     

 

 

Sign in today: Google for Work Connect (GWC) is your 
one stop shop for resources to make your work with 
Google Apps easier. Sign in today to discuss best 
practices, ask questions, and communicate with your 
peers and Googlers. Don’t miss out! Make sure you 
follow our Community Manager, Luis Vargas, to get the 
weekly buzz. 
 
What’s new: In March, the Q1 2016 Editorial Calendar 
came to a close with topics like working offline, 
performing research in Slides, and managing 
company-owned devices in Google Mobile 
Management. Kim Wylie’s Change Management series 
featured a guest post by Simon Barrow on returning IT 
to its roots of creativity and invention.  

Our Recommended Apps series hosted a Hangout on Air with RingCentral to discuss ways to extend Google 
Apps for communication use cases. Be sure to check out our Q2 Editorial Calendar over the next few months 
for more use cases to enhance your productivity.  

 
Google Apps for all: The Apps Show on YouTube, every Tuesday, 11am PST 

     Share with your organization  

 

What's new: In March, The Apps Show broadcast four new episodes 
showing how Google employees use Sheets, Gmail, and Groups to 
improve collaboration, productivity and efficiency at work. 
 
You will find a special episode on Gmail, in which our hosts share best 
practices on inbox management and tips on how to boost productivity.  

You will also find two episodes on Google Sheets. Our hosts let us know how they use Sheets to build project 
plans and employee workflows, as well as in the onboarding process of new employees. 
 
Finally, an episode gives us an overview of the Google re:Work website. This site provides guides and tools 
used by Google to make work a better and more efficient environment. Check it out! 
 
To do: If you find an episode useful, don’t forget to comment and share it with your friends and colleagues. We 
encourage you to bookmark The Apps Show YouTube playlist or episode gallery to keep up to date. 

 
What’s New for Apps Admins videos 

   Admin resource     

 

 

What’s new: The What’s New for Apps Admins videos provide a 
recap of all of the features we've released in the past month 
that are relevant to Google Apps Admins, so you can watch and 
share them whenever you want. 
 
How it works: Bookmark the playlist on YouTube and check 
back each month for the latest updates. You can also access 
all video recordings in the archive on the What’s New site. 

Thanks for checking out our newsletter!  
We’d really appreciate your thoughts on how we can make this work best for you. 
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